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Deploying an Infoblox Grid manually on OpenStack and configuring it could be a time-consuming task. In
a dynamic environment like a Service Provider setup, cutting short the deployment time is the key to
success. Zero touch provisioning (ZTP) of NIOS on OpenStack using Ansible enables infrastructure
teams to deploy Infoblox Grid on OpenStack without any manual intervention. It reduces the deployment
time and automates the initial configuration like setting up licenses, IP addresses and starting the
services.

Ansible is an open source software that automates software provisioning, configuration management,
and application deployment. Ansible connects via SSH, remote PowerShell or via other remote APIs.

An Ansible playbook contains one or multiple plays, each of which define the work to be done for a
configuration on a managed server. Ansible plays are written in YAML. Every play is created by an
administrator with environment-specific parameters for the target machines or servers.

Ansible plays are flexible due to modules, which pertain to various aspects of the target managed
servers. The module script is written in Ruby. Modules exist for many parts of system configuration,
including software installation and user management.

The playbook is therefore composed of plays, which are composed of modules. It executes when the

administrator runs the ansible-playbook command against target machines. The administrator must
use an inventory file to specify the hosts under the playbook's management. The inventory file contains a
list of all hosts that are managed by Ansible, and it offers an option to group hosts according to their
functionality.

For example, following sample playbook ensures that the apache is at the latest release, writes the config
file and enables the auto start feature.

- hosts: webservers
vars:
http_port: 8@
max_clients: 200
remote_user: root
tasks:
- name: ensure apache is at the latest version
yum: name=httpd state=latest
- name: write the apache config file
template: src=/srv/httpd.j2 dest=/etc/httpd.conf
notify:
- restart apache
- name: ensure apache is running (and enable it at boot)
service: name=htipd state=started enabled=yes
handlers:
- name: restart apache
service: name=httpd state=restarted
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https://whatis.techtarget.com/definition/Ruby
https://searchnetworking.techtarget.com/definition/host

The Ansible playbook discussed in the document addresses the following use cases:

e Deploying Grid Master
o Deployment
o License and network initialization using cloud-init
e Deploying a Member
o Deployment
o License and network initialization using cloud-init
o Adding the Member to the Grid.
e Starting DNS and DHCP services

e A working OpenStack (Newton release onwards) setup with sufficient resources to host Infoblox grid
(a minimum of 24 GB RAM, 8 vCPUs and 600 GB hard disk space).

e The vNIOS image for KVM (version specific or DDI) in the gcow?2 format.

e A Linux machine with Ansible (2.6.2 onwards) installed and access to the OpenStack setup.( Please
refer >
https://docs.ansible.com/ansible/2.5/installation _guide/intro installation.html#id15 )

¢ Download the Ansible playbooks from https://github.com/infobloxopen/nios-ztp-anisble.git to the
above-mentioned Linux machine with ansible installed.

1. Login to Openstack and navigate to Admin - Network - Create Network

T:openstack. ®admin-
Project >
Admin / Network / Networks

Admin v
owiew - NEIWOTKS

Compute >

Network v Project = = Filter || < Create Network

Routers
Floating IPs
System >

Identity >

N

Enter the name for this external network.

3. Inthe Project dropdown box, select the project name.

4. Inthe Provider Network Type drop down, select your provider network type.

In this deployment guide, we use Flat as provider network type and the name of the physical
network is public.

(For more information on OpenStack networking please refer >
https://docs.openstack.org/mitaka/networking-guide/intro-os-networking.html)
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5. Check the External Network check box and click on next.

Create Network

Subnet Subnet Details

Name Create a new network. In addition, a subnet associated
External with the network can be created in the following steps of
this wizard.
Project *
admin v
Provider Network Type * @
Flat v

Physical Network * @
public

& Enable Admin State

O Shared

& External Network

' Create Subnet

Cancel « Back
6. Inthe Subnet Name option enter the external network subnet name.
7. Inthe Network Address option enter the external network address in CIDR notation.
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8. You can enter the gateway. If you don’t, OpenStack by default takes the first IP Address as the
Gateway IP. Click on next.

Create Network

Network * Subnet Details

Subnet Name Creates a subnet associated with the network. You need

external-subnet to enter a valid "Network Address" and "Gateway IP". If
you did not enter the "Gateway IP", the first value of a
Network Address © network will be assigned by default. If you do not want
gateway please check the "Disable Gateway" checkbox.
10.196.200.0/24 Advanced configuration is available by clicking on the
"Subnet Details" tab.
IP Version
IPv4 A
Gateway IP ©
10.196.200.1

O Disable Gateway

Cancel « Back
9. Inthe next screen, check the Enable DHCP option.

10. In the allocation pool enter the IPs from the external subnet which you would like Openstack to
use as floating IPs. For example, 10.196.200.66,10.196.200.74 will allocate 9 IPs.
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11. Click on create to create the external network.

Create Network

Network * Subnet Subnet Details

v
& Enable DHCP Specify additional attributes for the subnet.

Allocation Pools @

10.196.200.66,10.196.200.74

DNS Name Servers @

Host Routes @

Cancel « Back

Creating Mgmt and Lan1 networks

NIOS requires a minimum of 2 networks to boot up successfully. In case it does not detect atleast 2
networks, it throws a Fatal Error during boot process.

In this deployment guide, we first create 2 networks for NIOS, called Mgmt and Lanl. Once the networks
are created, we create 2 ports in each network. Port of Lan1 network will be associated with the floating
IP so that Infoblox Grid can be accessed from outside of OpenStack.
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Creating Mgmt Network

1. Login to OpenStack and navigate to Project - Networks and click on Create Network.

E openstack. = admin~ & admin ~
Project v

Project / Network / Networks
API Access

Compute > NetWDrkS

Network v
Network Topology Name =~ Filter + Create Network il Delete Networks
Routers O Name Subnets Associated Shared External Status Admin State Actions

Security Groups

Floating IPs

Orchestration >

Admin >
Identity >

2. Enter the Network Name and click on next.

Create Network

Subnet Subnet Details

Network Name Create a new network. In addition, a subnet associated

with the network can be created in the following steps of
this wizard.

Mgmt

& Enable Admin State @
O Shared

& Create Subnet

Cancel « Back
3. Inthe Subnet Name option enter the Mgmt network subnet name.
4. Inthe Network Address option enter the Mgmt network address in CIDR notation.
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5. You can enter the gateway. If you don’t, OpenStack by default takes the first IP Address as the
Gateway IP. Click on next

Create Network

Network Subnet Details

Subnet Name Creates a subnet associated with the network. You need

to enter a valid "Network Address" and "Gateway IP". If
you did not enter the "Gateway IP", the first value of a
network will be assigned by default. If you do not want
gateway please check the "Disable Gateway" checkbox.
172.26.1.0/24 Advanced configuration is available by clicking on the
"Subnet Details" tab.

Mgmt-subnet

Network Address @

IP Version

IPv4 -

Gateway IP @

(0 Disable Gateway

Cancel « Back
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6. Check the Enable DHCP option and click on create.

Create Network

Network Subnet Subnet Details

<
& Enable DHCP Specify additional attributes for the subnet.

Allocation Pools @

DNS Name Servers ©

Host Routes @

Cancel « Back
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Creating Lan1 Network

1. Login to OpenStack and navigate to Project - Networks and click on Create Network.

E openstack. = admin~ & admin ~
Project v

Project / Network / Networks
API Access

Compute > NetWDrkS

Network v
Network Topology Name =~ Filter || 4 Create Network | S 8RR ENLLES
Routers O Name Subnets Associated Shared External Status Admin State Actions

Security Groups

Floating IPs

Orchestration >

Admin >
Identity >

2. Enter the Network Name and click on next

Create Network

Subnet Subnet Details

Network Name Create a new network. In addition, a subnet associated
‘ Lan-1| with the network can be created in the following steps of
this wizard.

 Enable Admin State @
O Shared

& Create Subnet

Cancel « Back
3. Inthe Subnet Name option enter the Lan 1 network subnet name.
4. Inthe Network Address option enter the Lan 1 network address in CIDR notation.
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5. You can enter the gateway. If you don’t, OpenStack by default takes the first IP Address as the
Gateway IP. Click on next

Create Network

Network m Subnet Details

Subnet Name Creates a subnet associated with the network. You need

Lan1-Subnet to enter a valid "Network Address" and "Gateway IP". If

you did not enter the "Gateway IP", the first value of a

network will be assigned by default. If you do not want

gateway please check the "Disable Gateway" checkbox.

192.168.2.0/24 Advanced configuration is available by clicking on the
"Subnet Details" tab.

Network Address @
IP Version
IPv4 v

Gateway IP @

O Disable Gateway

Cancel « Back
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6. Check the Enable DHCP option and click on create.
Create Network

Network Subnet Subnet Details

o4
& Enable DHCP Specify additional attributes for the subnet.

Allocation Pools @

DNS Name Servers @

Host Routes @

Cancel « Back
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Creating a Router

1. Login to OpenStack and navigate to Project - Network - Routers - Create Router
E openstack. = admin~ & admin ~

Project v
Project / Network / Routers

APl Access

Compute > RO Ute rS

Network v
Network Topology Router Name =~ Filter | < Create Router
Networks Name Status External Network Admin State Actions

m o tems o dsplay

Security Groups

Floating IPs

Orchestration >

Admin >
Identity >

2. Enter the Router Name and in External Network drop down option, select the external network
which you previously created.
3. Click on Create Router to create the router.

Create Router

Router Name

Description:

Creates a router with specified parameters.
@ Enable Admin State |

Admin-Router

External Network

External -

Cancel Create Router
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4. Once the router is created click on the name of the router.

Project -
Project | Network
AP Access
comue  ~ Routers
Network -
Netwark Topology Router Name =+ Filter + Create Router ' Delete Routers
Networks B B
Displaying 1 item
Routers
O Name Status External Network Admin State Actions
Security Groups .
0O  Admin-Router Active External up -

Floating IPs . .
Displaying 1 item
Orchestration N
Admin -
Identity

5. Navigate to Interfaces > Add Interface

Project
Project ' Network = Routers
API Access
come—~ Admin-Router .
Network -
Network Topology Overview Interfaces Static Routes
Networks
+ Add Interface | [ DEGEINCIERES
Routers

Security Groups Displaying 1 item

Floating IPs O Name Fixed IPs Status Type Admin State Actions
Orchestration - 0O (124e7637-7963) + 10.196.200.119 Active External Gateway up Delete Interface
fedmin Displaying 1 item
Identity

6. Inthe Subnet drop down option, select Lan-1 network and click on submit.

Add Interface

Subnet *

Description:
Lan-1: 192.168.2.0/24 (Lan-1-subnet) ~

You can connect a specified subnet to the
IP Address (optional) @ router.

If you don't specify an IP address here, the
gateway's IP address of the selected subnet
will be used as the IP address of the newly
created interface of the router. If the
gateway's IP address is in use, you must use
a different address which belongs to the
selected subnet.
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Creating Ports

We create ports with fixed IP addresses for both Lan1 and Mgmt networks. Once the ports are created

we bind the Lan-1 ports with the floating IP.

Creating portsin Lan-1 network

1. Navigate to Project > Networks and click on Lan-1

Project ~
API Access
Compute N
Network -
Network Topology
Networks
Routers
Security Groups
Floating IPs

Orchestration
Admin M

Identity

Project ' Network

Networks

Displaying 3 items

O Name
0O Mgmt
O Lan-1
O External

Displaying 3 items

2. Navigate to Ports - Create Port

Project o
AP| Access

Compute N
Network -
Network Topology
Networks

Routers

Security Groups

Floating IPs

Orchestration N
Admin M

Identity v

Name =~

Subnets Associated

Project | Network ' Networks
Lan-1

Overview Subnets Ports
Displaying 1 item

O Name Fixed IPs

O (b2b117bc-4d5d)

Displaying 1 item

3. Enter a Name for this port.
In the Specify IP address or subnet drop down option select subnet.

4,

« 192.168.2.2

Mgmt-subnet 172.26.1.0/24

Lan-1-subnet 192.168.2.0/24

10.196.200.0/24 10.196.200.0/24

MAC Address

fa:16:3e:30:81:e3

Shared External
No No

No No

Yes Yes

Attached Device

network:dhcp

Filter

Status

Active

Active

Active

Status

Active

+ Create Network

Admin State Actions
UP Edit Network | +
UP Edit Network | +
upP Edit Network |
Edit Ne k -
<+ Create Port
Admin State Actions
up Edit Port | =
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5. Inthe Subnet drop down option select Lan-1-subnet 192.168.2.0/24.
Create Port

Name o
Lan-1-Grid-Master DeSCI’IptIOH.

You can create a port for the network. If you

® Enable Admin State specify device |ID to be attached, the device

specified will be attached to the port created.
Device ID @

Device Owner @

Specify IP address or subnet @

Subnet -
Subnet
Lan-1-subnet 192.168.2.0/24 -

MAC Address @

& Port Security @

Cancel Create Port
6. Once the port gets created make a note of the port IP address

7. Repeat the same steps to create a port by the name Lan-1-Member for the grid member.
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Creating Ports in Mgmt Network

1. Navigate to Project - Networks and click on Mgmt

Project ~
Project ' Network
API Access
comue - Networks
Network -
Network Topology Name =+
Networks
Displaying 3 items
Routers O Name Subnets Associated Shared External
Security Groups
O Mgmt Mgmt-subnet 172.26.1.0/24 No No
Floating IPs
O Lan-1 Lan-1-subnet 192.168.2.0/24 No No
Orchestration -
O External 10.196.200.0/24 10.196.200.0/24 Yes Yes
Admin M
Displaying 3 items
Identity piaying

2. Navigate to Ports - Create Port

Project -
Project | Network ' Networks
API Access
Compute e Mgmt
Network -
Network Topology Overview Subnets Ports
Networks
Routers
Security Groups Displaying 1 item
Floating IPs O Name Fixed IPs MAC Address Attached Device
Orchestration v 0O (55f85d0a-d29e) « 172.26.1.2 fa:16:3e:f1:9¢:3d network:dhcp
Admin - Displaying 1 item
Identity =

3. Enter the Name for this port.

4,

In the Specify IP address or subnet drop down option select subnet.

Filter + Create Network 1ir Delete Networks
Status Admin State Actions
Active upP Edit Network | =
Active UpP Edit Network | =
Active up Edit Network |
Edit Network | ~
+ Create Port | i [pEISCREE]
Status Admin State Actions
Active UP Edit Port | ~
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5. Inthe Subnet drop down option select Mgmt-subnet 172.26.1.0/24.

Create Port

Name o
Mgmt-Grid-Master DeSCI‘IptIOF‘I.
You can create a port for the network. If you
# Enable Admin State specify device ID to be attached, the device

specified will be attached to the port created.
Device ID @

Device Owner @

Specify IP address or subnet @

Subnet -
Subnet
Mgmt-subnet 172.26.1.0/24 v

MAC Address @

& Port Security @

Cancel Create Port
6. Once the port gets created make a note of the port IP address

7. Repeat the same steps to create a port by the name Mgmt-Member for the Grid Member.
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Allocating and associating floating IPs to the ports presentin Lan-1 network

Allocating floating IPs
1. Navigate to Project > Floating IPs > Allocate IP to Project

Project -
Project = Network
API| Access

compue - Floating IPs

Network -

Network Topology % Allocate IP To Project | JEXJREIECEE L ETNIE=N

Networks
Displaying 1 item
Routers O IP Address Mapped Fixed IP Address Pool Status Actions
Security Groups
O 10.196.200.118 - External Down Associate |
Floating IPs
Displaying 1 item
Orchestration -
Admin b
Identity ¥
2. Inthe Pool drop down box select External and click on Allocate IP
Allocate Floating IP
*
Pool
Description:
External v
Allocate a floating IP from a given floating IP
poal.

Project Quotas

Floating IP

Cancel Allocate IP

3. Repeat the same step again to allocate one more floating IP.
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Associating floating IP to the Port

1. Navigate to Project - Floating IPs. Check the first floating and click on Associate.

Project v
Project / Network / Floating IPs
API Access
Gompute > Floating IPs
Network v
Network Topology % Allocate IP To Project €3 Release Floating IPs
Networks Displaying 2 items
Routers O IP Address Mapped Fixed IP Address Pool Status Actions
Security Groups & 10.196.200.74 - External Down Associate |
Floating IP:
Orchestration > . .
Displaying 2 items
Admin >
Identity >

2. In Port to be Associated drop down box select the Member port and click on associate.

Manage Floating IP Associations

*
IP Address Select the IP address you wish to associate with the

10.196.200.74 - + selected instance or port.

Port to be associated *

Member-1: 192.168.2.7 -

3. Navigate to Project - Floating IPs. Check the second floating and click on Associate.

f:openstack. ®admin~ pay—
Project v
Project / Network / Floating IPs
API Access
Compute » Floating IPs
Network v
Network Topology % Allocate IP To Project $5 Release Floating IPs
Networks Displaying 2 items
Routers O IP Address Mapped Fixed IP Address Pool Status Actions
Security Groups 0O 10.196.200.74 Member-1 192.168.2.7 External Down -
L & 10.196.200.71 - External Down Associate | =
Orchestration > ) ) i
Displaying 2 items
Admin >
Identity >
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4. InPortto be Associated drop down box select the Grid-Master port and click on associate.

Manage Floating IP Associations

*
IP Address Select the IP address you wish to associate with the

10.196.200.71 - + selected instance or port.

Port to be associated *

Grid_Master: 192.168.2.30 v

Uploading NIOS image to OpenStack

NIOS QCOW?2 image can be downloaded from https://support-internal.infoblox.com/support-downloads#

1. Login to OpenStack and navigate to Project > Compute > Images - Create Image

Project
Project Compute
API Access
Compute - Images
Overview
. e
Instances 2 Click here for filters X | < Create Image l
Images
Displaying 2 items
Key Pairs
(] Owner Name + Type Status Visibility Protected Disk Format Size
Network
O > admin cirros Image Active Public No Qcow2 12.65 MB Launch | v
Orchestration
Adrl O > admin ubuntu-16.04 Image Active Public No Qcow2 283.06 MB Launch | v
min
Identity Displaying 2 items

2. Enter the Image Name.
3. Inthe Format drop down option select QCOW?2 — QEMU Emulator.
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4. Click on Browse to select the image.
In this deployment guide, we use NIOS-810 QCOW?2 image.

Image Details Image Details

Metadata Specify an image to upload to the Image Service.

Image Name* Image Description

NIOS-810

Image Source

Source Type
File

File*
nios-8.2.2.363203-2017-11

Format *

QCOW2 - QEMU Emulator v

Image Requirements

Kernel Ramdisk

Choose an image v Choose an image v

Architecture Minimum Disk Minimum RAM
(GB) {MB)

0 0

Image Sharing

Visibility Protected

Public Private Yes No

x Cancel < Back Next » + Create Image
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Creating a Flavor

1. Login to OpenStack and navigate to Admin - Compute - Flavors - Create Flavor

Project >
Admin / Compute / Flavors

Admin v

Overview FlaVOFS

Compute v
Hypervisors =+ Create Flavor 1 Delete Flavors
Host Aggregates Displaying 14 items
Instances o Flavor  yepys gam  Root  Ephemeral - Swap - RX/TX D Public Metadata Actions
Name Disk Disk Disk factor
m O  cimos256 1 256MB 0GB 0GB oMB 10 et Yes  No Modify Access | =
Images
D ds1G 1 1GB  10GB 0GB oMB 10 d2 Yes  No Modify Access | =
Network >
System > 0O ds2G 2 2GB 10GB 0GB 0MB 1.0 d3 Yes No Modify Access | =
Identity > D ds4G 4 4GB 20GB 0GB oMB 1.0 d4 Yes  No Modity Access | =
D ds612M 1 512MB  5GB 0GB oMB 10 d1 Yes  No Modity Access | =
O milarge 4 8GB 80GB 0GB amvB 1.0 4 Yes No Modify Access |
D ? D g 4GB 40GB 0GB OMB 10 3 Yes  No Modify Access | =

2. Give a Name to this flavor.
3. Inthe VCPU option enter 2.
4. In RAM option enter 2048
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5. Inthe Root Disk option enter 300.

Create Flavor

- *®
Flavor Information Flavor Access

Name *
Flavors define the sizes for RAM, disk, number of cores,

NIOS and other resources and can be selected when users
deploy instances.

D@

auto

VCPUs *

2

RAM (MB) *

2048

Root Disk (GB) *

300

Ephemeral Disk (GB)

a

Swap Disk (MB)

0

RX/TX Factor

1

Cancel Create Flavor
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Creating a Security Group

1. Login to OpenStack and navigate to Project - Network - Security Groups - Create
Security Group

fTiopenstack. ®admin~ & admin ~
Project v
Project / Network / Security Groups
API Access
Corive > Security Groups
Network v
Network Topology + Create Security Group @ Delete Security Groups
Networks Displaying 3 items
Routers O Name Security Group ID Description Actions
Security Groups O Admin-SG  ab287169-ca80-4181-b979-3e5276addf40 Manage Rules | v
Floating IPs . 5 "
O  Infoblox 40fb93c8-a186-4ed6-b716-8c0e74fa586f This security group opens the ports needed by Infoblox DDI appliances. Manage Rules | ~
Orchestration >
O  default 8246b4b8-a571-431f-907b-0b6d891becee Default security group Manage Rules
Admin >
Displaying 3 items
Identity >

2. Enter a Name for this security group.

Create Security Group

Name *
NIOS-Security-Group| Descri ptl on:
Security groups are sets of IP filter rules that are applied
Description to network interfaces of a VM. After the security group is

created, you can add rules to the security group.

Cancel Create Security Group
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3. Once the security group is created click on Manage Rules

s:openstack. madmin~ & admin ~
Project v
Project / Network / Security Groups
API Access
Compute > Security Groups
Network ~

Network Topology 4 Create Security Group W Delete Security Groups

Networks Displaying 4 items

Routers O Name Security Group ID Description Actions
Security Groups O Admin-SG ab287169-caB0-4181-b979-3e5276addf40 Manage Rules |~
Floating IPs ) ) )

O Infoblox 40fb33cB-a186-4ed6-b716-8c0aT4fa586f This security group opens the ports needed by Infeblox DDI appliances. Manage Rules | ~
Orchestration >

O  NIOS-Security-Group  dcb8ca16-c2c6-4204-98e3-969bc358057f Manage Rules | ~
Admin b4

\dentit 5 0 default 8246b4b8-a571-4311-007b-0b6d891beese  Default security group Manage Rules
lentity

Displaying 4 items

4. Click on Add Rule

T openstack. @admin~ & admin ~
Project v
Project / Network / Security Groups / Manage Security Group Rul...
AP| Access
Compute > Manage Security Group Rules: NIOS-Security-
Network . Group (dcb9ca16-c2c6-4e04-98e3-969bc358057f)
Network Topology
+Add Rule | EsEEERRTERS
Networks
Displaying 2 items
Routers
O  Direction Ether Type IP Protocol Port Range Remote IP Prefix Remote Security Group Actions
Floating IPs O Egress 1Pv4 Any Any 0.0.0.0/0 -
Orchestration > O Egress IPv6 Any Any =0 -
Admin > Displaying 2 items
Identity >
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5. Add the following rules one by one to the security group.

TEopenstack. = admin-
Project v

Project / Network / Security Groups / Manage Security Group Rul
AP Access

Cormpute > Manage Security Group Rules: NIOS-Security-Group (dcb9ca16-
Networs . €2c6-4e04-98e3-969bc358057f)

Network Topology

Networks
Displaying 8 items

Routers
O  Direction Ether Type IP Protocol Port Range Remote IP Prefix Remote Security Group
O Egress IPv4 ICMP Any 0.0.0.010
Floating IPs
Orchestration > O  Ingress IPv4 ICMP Any 00000
Admin > =
D Egress IPva TCP 1-65535 0.0.0.010
identity >
DO  Ingress IPvd TCP 1-65535 0.0.0.010
D Ingress 1Pv4 TcP 22 (SSH) 0.0.0.00
D  Ingress IPv4 TGP 443 (HTTPS) 00000
DO Ingress IPva UDP 1-65536 0.0.0.010
D Egress IPv4 upP 1- 65535 0.0.0.010

Downloading the admin-openrc.sh

1. Login to the OpenStack and navigate to Project > API Access - Download OpenStack RC
File > OpenStack RC File (Identity API v2.0)
3 openstack. maimin~

Project v

Computs > APl Access

Project / API Access

+ Add Rule

& admin =

»
a
2
3
@

Delete Rule

Delete Rula

Delete Rule

Delete Rule

Delete Rule

Delete Rule

Delete Rule

& admin ~

Network >
Orchestration > @ \iew Credentials Download OpenStack RC File =
Admin 3 Displaying 8 items & OpenStack clouds.yaml File
& OpenStack RC File (Identity AP v2.0)
Identity > Service Service Endpoint & OpenStack RC File (Identity API v3)
Cloudformation http://10.196.200.5/heat-api-cfn/v1
Compute http://10.196.200.5/compute/v2.1
Compute_Legacy http://10.196.200.5/compute/v2/411943d268cd464990bea5456938628e
Identity http://10.196.200.5/identity
Image hitp://10.196.200.5/image
Network http://10.196.200.5:9696/
Orchestration http://10.196.200.5/heat-api/v1/411943d268cd464990bea5456938628e

2. OpenStack RC file shows up as admin-openrc once downloaded. If you are using windows
machine you can use WinSCP software to move admin-openrc file to the ansible machine.

Setting up the Ansible machine

1. Login to the Linux machine in which you have installed ansible.
2. Run following commands one by one to install openstack client.
apt-get install python-pip
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pip install python-openstackclient
apt-get install python-openstackclient
Check for the python-openstack client version by running openstack -version

root@ansible-server:/home/tme# openstack --version
openstack 3.16.0
root@ansible-server:/home/tme# I

Note: python-openstackclient recently got updated. Its ok if the version shows as 3.16.1 or
3.16.2.
4. Download the ansible playbooks by running
git clone https://github.com/infobloxopen/nios-ztp-anisble.git
root@ansible-server:/home/tme/infoblox-ansible# git clone https://github.com/infobloxopen/nios-ztp-anisble.git
Cloning into 'nios-ztp-anisble'...
remote: Enumerating objects: 25, done.
remote: Counting objects: 100% (25/25), done.

remote: Compressing objects: 100% (25/25), done.
remote: Total 25 (delta 9), reused © (delta @), pack-reused @

Unpacking objects: 100% (25/25), done.
Checking connectivity... done.
root@ansible-server:/home/tme/infoblox-ansible# []

5. Once the clone process is over you will see folder nios-ztp-anisble
6. cd to this folder. You should see following files.

e authl.json

e auth.json

® deploy grid master and member.yml

® join member.yml

e openstack_specific values.sh

¢ pre provision member.yml

e wait for grid master.yml

e zero_touch provisioning.sh

Note: Folder will have LICENSE, README.md file as well. These files can be ignored
7. Change the permission of the openstack_specific_values.sh and
zero_touch_provisioning. sh file make them executable by running following command.
chmod +x openstack specific values.sh
openstack specific values.sh

root@ansible-server:/home/tme/infoblox-ansible# chmod +x openstack_specific_values.sh zero_touch_provisioning.sh
root@ansible-server:/home/tme/infoblox-ansible#

8. Move the admin-openrc file to this folder. Source it by running following command. You will be
prompted to enter your OpenStack password.
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source admin-openrc
root@ansible-server:~# source admin-openrc.sh
Please enter your OpenStack Password for project admin as user admin:

9. To get parameters required to run ansible playbook execute

openstack specific_values. sh script by running following command
Jopenstack specific values.sh
root@ansible-server:/home/tme/infoblox-ansible# ./openstack_specific_values.sh

637b3a0e-727f-48fc-95b6-23e2736609d6 | NIOS-810 active

b94c9a3c-fe48-4877-b569-8ac3a6139586 | NIOS-DDI active

©53b5bdf-8288-4653-9daf-cbc78e7a02ac | cirros-0.3.3-x86_64-disk | active

7f3aele9-e088-475e-99aa-e51d4f7a91ca | cirros-0.3.5-x86_64-disk | active
+

root@ansible-server:/home/tme/infoblox-ansible# I

10. This script will generate a file > openstack values
root@ansible-server:/home/tme/infoblox-ansible# 1ls
authl.json openstack_specific_values.sh README.md
auth.json LICENSE openstack_values test_output.txt
join_member.yml NIOS_with_floating_ip_os_server_facts.yml pre_provision_member.yml zero_touch_provisioning.sh

root@ansible-server:/home/tme/infoblox-ansible#

11. openstack_values file has list of all the parameters which we will need to run the ansible
playbook for NIOS deployment on OpenStack.

12. Verify the contents of openstack_values file by running following command
less openstack values
root@ansible-server:/home/tme/infoblox-ansible/git_files/nios-ztp-anisble# less openstack_values

13. To deploy NIOS using ansible we will need IDs for following parameters

Parameter Name Description Sample
image QCOW?2 image for Grid Master and Member 637b3ale-727£-48fc-95b6-
deployment 23e2736609d6
flavor Resource details (RAM, CPU and Hard Disk) 92aff88f-839f-479b-9156-
for Grid Master and Member 4be2a3c3594b
Port details for the Mgmt network port-name=84dad4e8c-3af9-41b3-
nics bfc0-927095e420cd, port-
Port details for the Lan-1 network name=0f12f865-9c56-4cc0-9£85-
83047e240163
security_ groups | Outgoing and Incoming traffic policies for Grid- | ab287169-ca80-4181-b979-
Master and Member 3e5276addf40
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Editing Deploy Grid-Master section
Replace the values in red box with the values you will get from openstack_values file

Enter the image id

Enter the flavor id

Enter the security groups id

Enter the Grid-Master-Mgmt port id

Enter the Grid-Master-Lanl port id

Enter the IP address of the Lanl port for Grid master

Enter the Lan-1 subnet in CIDR

Enter the Lan-1 default gateway

. Enter the name of the external network

10. Enter the name of Lan-1 network. (Name which you gave while
creating it in Horizon)

11. Enter the IP address of the Grid-Master-lanl port.

OWoOoJdJoy Ul WNR

Note: Do not change the order of port IDs. First port id will be of Mgmt port and second port id will
be of Lan-1 port.

launching VNIOS
localhost

Deploy Grid-Master
\p
ame: Grid_Master

present
637b3ade-7271-48tc-95b6-23e2736609d6

: 3
92aff88F-839F-479b-9156-4be2a3c3594b Py

y_groups 1b287169-ca80-4181-b979-3e5276addF40*

yes I

te_console_enabled: y
p_license: vnios dns dhcp enterprise
11t_admin_g word: infoblox
‘/;,//6
ddr: [192.168.2.30|“" 7
k: 255.255.255.0/«
192.168.2.1), _
p
present
yes
Grid_MastiE/g
External 0
Lan-1

192.0.2.30

11

Similarly edit the Deploy Member-1 section of the file.

1. auth. json file contains information about the member which will be pre-provisioned in the grid
in json format. This file is used pre_provision_member.yml file.
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2. Edit the values which are highlighted in red box.
1. Enter the name of the member

2. Enter the Lan-1 subnet

3. Enter the Lan-1 IP address of the member. (This will be the
IP address of the port created in Lan-1 network for member)

4. Enter the Lan-1 network gateway.

"config addr _type":
"platform”: :
"host_name":
"vip_setting”

J

"subnet_mask":"
"address”:"
"gateway”

1. authl. json file contains information about the Grid-master in json format. This file is used in
join_member.yml file.
2. Edit the values which are highlighted in red box.

1l. Enter the name of the Grid. Default value is Infoblox
2. Enter the shared secret. Default value is test

3. Enter the Grid-Master Lan-1 port IP address.

© 2020 Infoblox Inc. All rights reserved. Zero Touch Provisioning of NIOS on OpenStack using Ansible January 2020 Page 32 of 37



"grid_name":"
"shared_secret”:"
"master”:"

}

1. Source the admin-openrc file. You will be pted to enter OpenStack password.

root@ansible-server:/home/tme/infoblox-ansible# source admin-openrc.sh
Please enter your OpenStack Password for project admin as user admin:

Run pwd command to find out the current directory where all the playbooks are present

root@ansible-server:/home/tme/infoblox-ansible# pwd
/home/tme/infoblox-ansible

root@ansible-server:/home/tme/infoblox-ansible# 1ls
admin-openrc.sh deploy_grid_master_and_member.yml pre_provision_member.yml
authl.json join_member.yml wait_for_grid_master.yml

auth.json openstack_specific_values.sh zero_touch_provisioning.sh
root@ansible-server:/home/tme/infoblox-ansible# [

© 2020 Infoblox Inc. All rights reserved. Zero Touch Provisioning of NIOS on OpenStack using Ansible January 2020 Page 33 of 37



Edit the zero_touch_provisioning. sh file using vim editor and update the absolute path
(obtained from the previous step) of the deploy grid master and member.yml file

PLAY_BOOK="
EXIT_STATUS=
ansible-playbook

if [

4. Invoke the zero_touch_provisioning. sh script and pass the floating IP, associated with
the Lan-1 port of Grid-Master as a positional parameter using following command.
./ zero_touch provisioning.sh “floating ip associated with Lan-
1 of grid master”
root@ansible-server:/home/tme/infoblox-ansible# ./zero_touch_provisioning.sh "16.196.266.71H

Ansible will start the play, post execution of zero touch provisioning.sh script.
root@ansible-server: /home/tme/infoblox-ansible# ./zero_touch_provisioning.sh "10.196.200.71"

PLAY [launching wNIOQS] *#%###sssiiiiiiiiiiiioioiiooioooiofooooooooooooooooooooooooloool ool ool ool ool ool ool olololololololololololololololololololololoolooooooo ool ok

TASK [Gatherdng Facts] w0088 o8O 5888 O 588K RO KKK R ROR ROK KOK R ROR KKK R ROR B0k KK

TASK [Deploy Grid-Master] *%%#&sksssssmmdi s hm s dkak ik fh sk f kR SRR SRR R AR AR AR R R RN

changed: [localhost]

TASK [as_floatlng_lp] ke ok o o o o o o ol o o o o o o ol oo o o o o ol o o o o o o o o e oo oo o o oo oo o o o oo oo oo oo oo o BB RO RO OB OROR RO RORORORORROROKOOR HOROROROKOOR HOROROROKOROR HOROKOROK

TASK [Deploy Member-l] 00 O O 0 O O O o o 0 o 0 0 0 0 0000 0 0 000 0 000 0 0 0 0 O 0 O O K

changed: [localhost]

PLAY [waiting for the Grid_Master to come online] e o e o e o ol e ol e o e o ol e ol o e o ol ol o o o ol ol o ol e o ol ol o ol ol ol ol o o ol ol ol o o o R R R o R R R R R R R OR R OB R ROk

TASK [Gathering Facts] e o oo o o o o o o o o o B o o o o o e o o o o o e o o o o o o o o o o o o o R B BB BB B B B BB B B B B K R B R K R R R K OB R K
TASK [OS server facts] st s s o o o o o o ol o o o o o o ol o o o o ol o o o o o e sl o e s ol ool o e ool ool o o e ol ool ol s oo o B SRR B R B R B R R SRR R R B R R R R R R R R KR R R R R R R OR R R R RO

TASK [Checking http status] o oo o o o ool oo o o o o ol oo o o o o oo o oo oo o o oo o oo o oo oo oo o oo oo o R R RO RO R ol RO RO R RO OROROKOOR HOROROROROROR HOROROROROROR RO OROR
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6. Post successful execution of all the playbooks you will get a prompt that Infoblox Grid is
deployed.

TASK

TASK

ok

unreachable=0 failed=0
Starting DNS and DHCP services
"result”: "member:dhcpproperties/ZG5zLmllblWIllcl9kaGNwX3Byb3BlcnRpZXMkMA:infoblox.localdomain”
"result": "member:dhcpproperties/ZG5zLmllblW]1c19kaGNwX3Byb3BlcnRpZXMkMQ:memberl. localdomain.com™

"result”: {
" _ref member :dns/ZG5zLmllbWIlc19kbnNfcHIveGVydGlleyQw: infoblox . localdomain”
"enable_dns": true

}

"result”: {
"_ref": "member:dns/ZG5zLmllblW]1lc19kbnNfcHIveGVydGllcy(Qx :memberl.localdomain.com”,
"enable_dns": true

}
} *#% Infoblox Grid is deployed
root@ansible-server: /home/tme/infoblox-ansible# I

7. Login to horizon dashboard and verify that Grid-Master and Member have been deployed and in
a running state.
s :openstack. ®azomin~ & admin ~
e . Instances

Instance ID =~ Filter & Launch Instance -

Displaying 2 items

Key Pairs — Instance Image |P Address Flavor Key Status Availability Task Power Time since Actions
Name Name Pair Zone State created

Lan-1
192.168.2.7
Admin > a NIOS-810 AEME - ctive nova None Running 9 minutes Create Snapshot |
101 74
Mgmt
172.26.1.22

Lan-1
192.168.2.30

_ NIOS-810 Floating IPs

nova None  Running 9 minutes Create Snapshot | =
10.196.200.71

Mgmt
172.26.1.11
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8. Login to the Infoblox Grid using https://floating ip associated with Lan-
1 port of grid master and verify grid status.

Infoblox ;:' Dashboards  DataManagement  SmartFolders MEI"BM Administration Q search  admin  ~
H b Addnsl]

Upgrade Licenses HSM Group

Finder « Toolbar
Infoblox @ » %

(88 Smart Folders. "
(= g -
7'r Bookmarks + DHCP | DNS | TETP | HTIP(FileDist) | ETP | NTP | bloxTools | Captive Portal

m

|o) Recycle Bin +
[E§ URL Links + Services

Quick Filter None ~ showFitter  [[Ea] Replication Status View

B Group Results Group By .

Goto = AT I -1l IP P 3 e Restart Services
& control +

[ ] Name HA Status 1Pv4 Address IPvG Address Identify DHCP DNS
[ & infoblox localdo. No I 192 168 2.30 e
& & membert locale No [Running  [REVRTEER

2= Giid -
- — Properties

L - & Backup v
B Restore ~

& Snapshot  ~

ﬁ Configure
Captive Portal

.

o= Download =

B certificates =

&+ Traffic Capture

dad

=]

9. Click on Services tab and verify DHCP status. (It should be up and running for both Grid-Master
and Member.)

|nf0b|0)( ;:‘ Dashboards Data Management Smart Folders Grid Administration QSearch  admin |+
o i e rwiw.

Upgrade

Finder «
Infoblox @ # %«
[38 Smart Folders + [
+ Bookmarks + il DNs | TETP | HITP(FileDist) | ETP | NIP | bloxTools | Captive Portal
& Recycle Bin +
R URL Links .
DHCP | g
Quick Filler None v | ShowFilter  Toggle Restart Groups View _
Backup ~
Group Results Group By B Restors |~
Goto Go Bl b | B P o Download =
M Name Service Status IPvd Address Comment Site MExport -
[] 4 infobloxlocal [T TR 192.168.2.30 = Pint
[RIR YT ENEYY DHOP Service is working 192.188.2.7 “§ CSV Import
9, CSV Job Manager
= IDN Converter
~
-~
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10. Click on DNS tab and verify its status. (It should be up and running for both Grid-Master and
Member.)

|nf0b|0x ;:- Dashboards Data Management Smart Folders Grid Administration Q Search  admin  +
conrmo o v

Upgrade L 5 HSM Group

Finder Toolbar »
Infoblox @ » %« a
)l Smart Folders
o acd -
¢ Bookmarks
=
E Recycle Bin m Restart Services
E URL Links Members ' Edt |+
NS W b
Quick Filler None v ShowFilter  Toggle Restart Groups View -
& Backup -
& Restore =

a2 Dovnload =

§3 Manage Dynamic

W Name Service Status IPvd Address. Comment Site
- Update Groups
[] 4 infoblox.localc 102,168 2.30
LN PP IEY] DNS Service is working 192168.2.7 MEort -
=1 Print
“88 CSV Import
9, CSV Job Manager

= IDN Converter

']
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